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Manual Change Information 
Customers should note that this manual is up to date at time of issue, but is not subject to automatic 

update. 
For additional information concerning the latest changes to this document,  

please consult our website members section: 
http://www.ver-mac.com/extranet/en/members 

 
We value your opinion! 

Please leave any thought on our products in our feedback section of the support page, here 
http://www.ver-mac.com/extranet/en/feedback 

 

 
 

Follow us      https://www.facebook.com/VermacInc  https://www.linkedin.com/company/ver-mac 

 

Technical Support 
For help with any difficulties concerning JamLogic units or this manual, please contact Ver-Mac Support: 

support@ver-mac.com 
 

Disclaimer 
 

Failure to read and follow the instructions and procedures contained in this manual could result in failure 
of the equipment, damage and serious injury. 

The owner is responsible for the proper use and maintenance of the equipment. 
Failure to properly maintain equipment can also void all guarantees. 

This manual contains a complete list of all scheduled maintenance intervals for all Ver-Mac JamLogic 
units. 

Please work safely. 
We also request that you notify us of any error  

or omission found in our publications. 
 

Information contained in this manual may be modified or corrected without notice. 
No part of the contents of this manual may be reproduced or transmitted in any form or by any means 

without the written permission of the publisher. 
© MMXVIII Signalisation Ver-Mac Inc. 

All rights reserved 
Ver-Mac® is a registered trademark of Signalisation Ver-Mac Inc. 
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1 The Basics 
1.1 Welcome 
JamLogic is the software component of Ver-Mac’s Traffic Management System. The JamLogic icon-
driven software menus control most roadside equipment comprising a Traffic Management System in 
any location and under any conditions in a cost-effective, safe and reliable way with minimum disruption 
to traffic. 
  
All your signaling and messaging using the same software package 
Without necessarily moving to the actual installation site, authorized users can easily configure and 
operate all devices as well as tune customized solutions to specific traffic management needs. Because 
JamLogic is built on a Windows platform, both the look of the screen and the way you interact with the 
software are similar to other Windows applications. 

1.2 What you Will Need 
1.2.1 Minimum System Requirements 

 Microsoft .NET Framework 4.5.1 
 Windows Vista or better 
 Access to Internet 

1.2.2 Account and Password 
1. First you have to contact Ver-Mac Support to ask for an account. 
2. You then receive an email with a link and instructions. 
3. Click the link and follow the steps exactly as instructed. 

1.3 Logging In 
You have installed the JamLogic client application on your computer. You now need to connect to the 
server. 

To access JamLogic, click the icon  on your Desktop or in the Start menu and follow the steps 
shown below: 
 

 
Figure 1: Connecting to JamLogic  

1. From Server list box, select server name according to the welcome email you received. 
a. Svr1.jamlogic.com is usually the one to select if your devices are located in North 

America. 
b. Svr2.jamlogic.com is the one for outside North America.  

2. In User, type your username. 
3. In Password, enter your password. Click OK. 
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2 JamLogic Guided Tour 
2.1 The Main Window 
This is how the main window appears (see Figure 1) after you have successfully logged in: 
 

 
Figure 2: JamLogic main window 

 
Menu bar – Click on title to pull down menu. 

 
Tool bar – Mouse over buttons to display their tooltips. Only the relevant options are enabled in 
the toolbar. 

 Folders contain devices. - Note: Folders can also contain subfolders with devices in them. 

 
Devices - The blank area in the center section will display a list of all the Devices in the 
selected folder or subfolder. To display the Devices list, first select a folder (see Figure 3). 

 Map shows the location of the devices. 

 Tasks display the progress of any operation you run on the selected device. 

 
Properties (characteristics) of the selected device below the Map. This section includes 
detailed information on the selected device like last log values, parameters, status. 

 

  TIP 
Take a minute to move the screen elements around, you can rearrange toolbars, move 
around the lists, get it to fit your screen size and the way you like to display data. 

 

Information in the Devices list  includes: 
• Type - displays device icon or installation pattern (traffic signals). 
• Status - current operating condition. A green hexagon indicates everything is normal. A red or 

yellow status hexagon indicates the kind of problem. 
• Name - label given to the device by the user. 
• Voltage - voltage reading. 
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• Value - the information reported by the device at last observation or the current information, if 
device is automated. 

• Image - view from CCTV camera updated once a minute. 
 

 
Figure 3: JamLogic main window 

  TIP 
Know your organization: If you have to contact Ver-Mac Support to resolve a difficulty, 
you will be asked for this information. 

 
In the status bar (see Figure 4) of your screen, you will find information concerning: language; 
organization; local time; UTC time difference. 
 

  
Figure 4: Status bar 

  TIP 
To find out a specific device status or problem, hold your cursor over the Status icon in 
the Device list. 
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2.2 Menu Bar 
Menu items with an asterisk (*) are restricted to certain users. 

 File menu 
• Change Organization - changes organization. 
• Quit - exit JamLogic. 

 

 Edit 
• Cut – removes a selected item, as long as you paste it. 
• Paste – pastes a copied or cut item. 
• Rename – renames an item. 
• Delete – completely deletes an item. 

 

 View menu 
• Toolbar - display/mask the toolbar. 
• Folders - displays the Folders panel. 
• Device List - displays the Device List panel. 
• Task List - displays the Task List panel. 
• Map - displays the Map panel. 
• Properties - displays the Properties panel. 
• Layout - displays Default layout of panels. 

 

 Tools menu 
• User Management - opens User Management window*. 
• Update controllers - opens Update Controllers window*. 
• Import Radar Data - opens USB Data logger window. Refer to the Radar Data Logger (RDL) 

manual for more information. 
 
 

  NOTE 
For JamLogic users of the former versions, please note that Show Device Data 
and Logs are now available in the main tool bar. 

 

 Options menu 
• Change Password - allows you to change your login password. 
• Language - allows you to select your choice of language. Regional settings are applied 

according to the associated country's flag. 

 

 Window menu 
• Close All - allows you to close all the windows. 
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2.3 Tool Bars 
Buttons on the tool bars are enabled according to the selected device types in the Devices list and user 
security profile. Menu items with an asterisk (*) are restricted to certain users. 
 
Device management tool bar 
 

 
                                      

 

 Search — A drop-down menu allows to add search options.  

 New device wizard, this is where you start when you want to add a new device. 

 Add new folder, for a specific project with several devices. 

 Communication settings, to modify parameters set in the New device wizard. 

 Share a device with others organizations. 

 New route wizard (Ver-Mac only) 

 Edit Corridor completely deletes an item. 

 Delete folder completely deletes a folder. 

 Flowchart Editor* 

 Workflow Editor* (Ver-Mac only) 

 Logs* opens a window allowing to track log messages from selected devices on a 
period of time of your choice. 

 Show device data* show data gathered by the device, following types and period of 
your choice. 

 Mailing Lists Editor opens a window to configure e-mail alerts. 

 Schedule Editor opens a window to configure schedules on certain devices. 

 Get Status refreshes the device’s status 

 Get GPS Position  
Note: This icon becomes available only after the GPS configuration is complete in the 
Communication settings. 

 Edit Date/Time opens a window to configure the device’s date and time. 
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VMS (or PCMS) functions tool bar  
Menu items with an asterisk (*) are restricted to certain users. 

 
                                                                 
 

 Message editor opens a window to create messages. 

 Display message opens a folder browser to pick a message. 

 Display blank message flushes the current message. 

 Graphic editor opens a window to create a picture to display. 

 Display graphic opens a folder browser to pick a picture. 

 Schedule editor opens a window to create or edit device schedules. 

 Activate schedule opens a folder browser to pick a schedule. 

 Brightness setup opens a dialog box to toggle between automatic or manual 
brightness settings. 

 Full VMS maintenance launches a series of tests. 

 SNMP Security sets administrator and user community names. 

 DBS Management is an advanced function for Ver-Mac support.* 

 Edit default message parameters — obtains default settings for a new message on a 
selected device and allows you to change them and send them to the device by clicking 
Send. 

 Edit control parameters — Pick default messages that the controller will display 
according to different events. Also this is where you can restart the controller 

 Override Message* (available only with automated tasks) opens a window to override 
the current message for a certain time and pick a message for that period. 

 Stop Override* simply removes the override. You must reactivate the previous 
message. 

 USB Data Profile. To upload-download data with a Ver-Mac PCMS. See chapter 9. 

 Event Logs Configuration* open a window to configure events log for the selected 
device. 

 
PTSS (portable traffic signal system) functions tool bar 
 

 
                    
 

 Signal Plan editor opens a window to create all the phases of your signal plan. 

 Send Signal Plan opens a folder browser to pick a signal plan. 

 Schedule editor opens a window to create or edit device schedules. 

 Send Traffic Light Schedule opens a folder browser to pick a signal plan schedule. 

 Setup Mail Alarm opens a window to setup settings for email alerts. 

 
Generate Traffic Light Report opens a window where you select date and time span 
for a statuses log on a web page. 
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Radar functions tool bar 
 

 
        
 

 Radar Setup opens a window to set speeds and sensitivity.  

 Download datalogger logs allows you to get RDL logs on a flash support such as a 
USB key. 

 
Camera functions tool bar 
 

 
        
 

 Show associated image opens a window with a snapshot of what the camera is 
pointing on. 

 Control uses the camera’s web interface to pan, tilt and zoom. 
 
Highway Advisory Radio (HAR) functions toolbar 
 

 
                   
 

 Activate HAR audio opens a window to pick an audio file. 

 
HAR override opens a window to override the current audio file for a certain time and 
pick another audio file for that period. 

 
Stop HAR override cancels the override. You must then activate the previous audio 
file. 

 Feedback HAR audio plays the current audio when you click it. 
 
Default Messages 
A default message is a message you wish to display when there are no special event. If you wish a 
device to go back to a default message, once selected, all you have to do is right-click the device and 
select Activate default message from the shortcut menu. 

 
              
 

 
Activate default message will send to the VMS a message you have previously picked 
as default. 

 Change default message opens a navigation window to find a message to use. 

 Set default message as blank turns the screen black when you go back to default. 
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2.4 Map 
The map will center on a device if you type its GPS coordinates when configuring communication 
settings. 
 

Icons Shown on Map 
Icon Name Definition 

 
VMS (Variable Message 
Signboard) Both portable and fixed VMS (Variable Message Signboard) 

 
PTSS - Portable Traffic 
Signal System All traffic signals (lights) and all intersection types 

 
Radar (Doppler/RTMS) Traffic data sensors 

 
Camera All cameras  

 ResetBox Optional device that resets the equipment based on certain 
settings or remotely from JamLogic 

 

 

 

Device cluster 

Many devices located within a small geographic area on the 
Map. The icon takes the color of the device with errors if 
present, to draw your attention quickly. Zoom in to find the 
error. 

 
Highway advisory radio 

HAR transmitter. It’s a device that can receive audio files from 
JamLogic that contain information for motorists and that the 
HAR transmits to local radio channels. 

 
You can filter devices on the map: 

 Click the Filter button in the Map toolbar and select which devices you wish to display. 

 
Figure 5 - Filtering devices in the map 
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2.5 Rearranging the Main Window Layout 
There is a wide variety of JamLogic user types using all the possible screen sizes, this is why JamLogic 
provides a lot of freedom in the windows layout. Take control of these options to make your environment 
more flexible. 

2.5.1 Tool Bars 
You can arrange the tool bars according to your personal preferences: 

 To realign the tool bar groupings, click the sizing handles (dotted line between the tool bars) and 
drag and drop the tool bar to where you want it. 
 If certain tool bar icons do not appear in a tool bar grouping, simply click the tool bar expansion 
handle for the grouping and click the missing icons. 

2.5.2 Panels 
You can also change panels’ layout: 

 To expand or reduce a section, drag the sides of the panel to where you want it. 
 To hide a panel, click X on the upper right of that panel. 
 To display a panel, select the panel name from the View menu drop-down. After the panel 
appears, position it where you want. 
 Select View > Layout > Default to return to the default layout via the View menu. 

2.5.3 Device List 
 Clicking the different column headers (Type, Name or Voltage) sorts the Devices list by the 
selected column values. 
 Holding the shift key down and clicking on a column header enables sorting with additional 
columns. 
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3 Working with Device Folders 
Folders hold all the devices for a given organization. Folders can also contain subfolders. 

3.1   Creating Folders 
1. Select a parent folder where you wish the new folder to appear. 
2. Click Add new folder. 
3. Type in a name for the new folder in the Add New Folder dialog box (see Figure 5). 

 
Figure 6: Add New Folder dialog box 

The new folder appears in the selected tree view, in alphabetic order (see Figure 6). 

 
Figure 7: New folder in its tree view 

3.2   Deleting One, or Multiple Folders 
1. Select one folder, or use the CTRL key to select multiple folders to delete. 
2. Click Delete folder either from the Device Management tool bar or through a right-click. 
3. You will be prompted to confirm for each folder (see Figure 7): 
 Click Cancel to stop the procedure. 
 Click Yes to confirm deletion of the specific folder. 
 Click No to cancel deleting the specific folder. 
 Select Apply to all, then Yes or No to do all the folders in one batch. 

 
Figure 8: Deleting a folder 

  NOTE A folder must be emptied of all Devices and subfolders before you delete it. 
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  TIP 
Folders facilitate the prioritization of your projects and Devices. Use subfolders to help 
you further organize your Devices. 

 

3.3   Sharing Folders 
 

  NOTE 
Set the sharing rights of the organization and users before sharing any devices or 
folders. The list of organizations you are allowed to view depends on your account 
security level. Call Ver-Mac if you require to change your JamLogic account.  

 

1. Right-click the folder to share. 
2. Select Share  from the shortcut menu. 
3. Click Add organization  to open the Select an organization window. 
4. Select the organization to share the folder with (see Figure 8) and click OK. 
5. Click Save . 

 
Figure 9: Manage shares dialog box 
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4 Devices 
A Device in JamLogic is a virtual representation of an electronic traffic equipment that is able to 
communicate with the JamLogic server via Internet. The electronic traffic equipment may be connected 
to the Internet with different communication equipment (modems, fiber optics, radio, etc.) JamLogic 
covers the following communication protocols (regardless of the medium): TCP and UDP. 

4.1   Creating a Device 
The 2 main scenarios for creating devices are networked devices and cameras. Because most 
equipment that connects in JamLogic uses a modem, they are networked. 

1. From the Device management tool bar, click  New device wizard. This opens the 
Connection Settings window. 

2. In the top horizontal icon list, select the device you are creating. If you are not sure which 
icon, mouse over to see a device description. 

3. In Generic settings, type a description for the device. 
 In the Network group, for a device that communicates with a modem, (see Figure 9): 
a) Select the communications protocol from the drop-down menu. 
b) Enter the IP address. 
c) Enter the port number. 

 
Figure 10: New device wizard settings dialog box for Networked Device 

  TIP  
If you do not have all the necessary information in order to complete 
the Network Settings section, please contact Ver-Mac Support for 
assistance. 
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 For light towers and camera devices (see Figure 10): 
a) Select the camera icon or select the light tower icon for light towers and power 

platforms.  
b) Enter the Image URL, click Test to test the URL.  
c) Enter the Camera URL and click Test to test the URL, or the light’s modem URL (ex: 

http://192.168.1.2). 
d) For light towers, type a password if required. 
e) In the Connectivity list box, select Online. 

 
Figure 11: New device wizard settings dialog box for a camera device 

If you have created a Networked Device, expect a short delay and a series of messages. 
JamLogic will use the provided information to connect to your equipment and get modem and 
device models and much more. 

4. When progress bar finishes, verify device and communication information. Click Next once 
again (see Figure 11). 

5. If you get an exception message, there was a failure to communicate with a device. If this 
occurs, click Back, review and correct the Network Settings (see Figure 11). 

6. If the device already exists, you get a message telling you its name and Enterprise owner 
(see Figure 12). 
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 OR  
Figure 12: Add new device auto-detection in progress, success and failure examples 

 
Figure 13: Add new device auto-detection in progress, existing device example 

7. Click Next. You will then see a browse dialog box (see Figure 13) where you have to pick or 
create a folder. 

8. Pick a folder and type a name this new device in the Name text box at the bottom. 
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Figure 14: Add new device wizard folder selection window 

9. Click Finish to return to main screen. 

4.2 Creating Virtual Devices 
If you wish to simulate a plan for the next work zone, virtual devices could be a useful feature. You can 
select from a wide variety VMS, speed trailers and radars. Virtual devices have limited functions; you can 
activate messages and blank the panel. 

1. Go to the folder where you wish to create the device. 
2. Click New Device Wizard and select the virtual device. 
3. Type a name and description. 
4. In the Type drop box, select VMS, speed trailer or radar. 
5. In Model, from the Template drop box, select a radar type or a display size. Use Table 1 to 

find the resolution for your model. 

6. Click Next and enter a name. In virtual mode, your device icon will be over a cloud . 
7. Repeat for all the virtual devices you wish to create. 

 

Model Template Physical description 

PCMS-1500C 30x56 

Trailer mount 

PCMS-1500 30x48 

PCMS-1500LP 28x48 

PCMS-320 30x48 

PCMS-548 30x56 

B-1500C 30x56 

Post-mount 
B-1500 30x48 

B-320 30x48 

B-548 30x56 
Table 1 – Virtual devices templates 
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4.3 Finding an Existing Device 
 Click a folder or subfolder to display its contents in the Devices panel list. To display the 
subfolders, click the twisty (triangle) to the left of the folder.  

4.3.1 Using the Search Feature 
To find devices, you can use the search box at the top, below the menu bar: 

1. Click in the search box and type a key word. The Device List will display the results.  
2. You can select several search criteria if you click the drop-down arrow (see Figure 14). 
3. Mouse over the device name to find its folder. The search result will remain until you perform 

a new one; you can select other folders and go back to the results afterwards. 

 
Figure 15: Searching for a device 

4.3.2 Working with Devices 
To begin working with a particular device, click its row to select it from the Devices list. 

 As long as coordinates were entered, the device displays circled and in the center of the Map 
view. A cluster icon displays if several devices are geographically located close together. 
 The selected device display properties (specific characteristics) below the Map. The properties 
displayed cannot be changed. 
 The buttons for the selected device types are enabled in the tool bar, allowing you to access the 
device functions. 

 

  TIP  
If no devices are displayed in the Devices list, you might not have selected a folder or 
created any devices. 
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4.4 Devices Communication Settings 
You can modify any parameter within the communication settings of a device: 

1. Right-click the device to modify. 
2. Select Communication Settings from the shortcut menu. 
3. Modify the parameter within the corresponding text box. 

 
Figure 16: Communication Settings dialog box 

 

  CAUTION  Changing communication settings for devices may result in loss of 
communication with the device. Proceed with care. 

 

Setting Description 
Description This text box allows to describe the device characteristics, could be a good place to put 

the VIN/serial number. 

Image URL 
This text box provides the option to enter the URL address of an image (e.g. picture of 
the device, surveillance camera view, etc.). The image will then be displayed in the 
Devices list next to the selected device. 

Road This text box lets you identify the road where the device is installed. 

Mile Post This text box lets you indicate a numbered marker on a road or a highway. 

Direction This text box lets you state the traffic flow (e.g. eastbound, southbound). 

Landmark This text box lets you note a describe landmark near a device (school, underpass). 
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4.5 Sharing Devices 
Devices can be shared across organizations. This feature, restricted to certain users, allows an 
organization to keep control of the device all the while letting a second party use it. 

1. Right-click the device to share. 
2. Select Share  from the shortcut menu. 
3. Click Add organization  to open the Select an enterprise window. 
4. Select the organization to share the device with (see Figure 16). 
5. Click Save . 

 
Figure 17: Manage shares 
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5 Variable Message Signboards 
A variable message signboard (VMS) is used to display Messages or Graphics. It can be either portable 
or permanently installed. You can use JamLogic to assign Messages or Graphics directly to the VMS, 
schedule VMS displays or automate the displays through administrator options. 
 

  TIP 
Make sure you have selected your VMS device(s) in the Device panel. If your devices 
are not selected, you cannot access functions associated with the VMS. 

 

When taking your first steps with posting messages, try posting a couple of tests messages first, to get a 
feel of the procedure. Then build a message bank, you will be ready when you need a quick turnaround. 

5.1   Posting a Message on a VMS 
You need to create a message before posting. Chapter 6, Creating Messages, describes in full the 
message editing procedure, but most JamLogic users already have a message bank. To post a 
message: 

1.   Click Display Message. 
2. From the Display message dialog box (see Figure 17), browse the folders and select your 

message. You can preview the messages as well as their optional beacon, in that window, 
and if they have several pages, you will see them scroll. 

 
Figure 18: Selecting a message to display 

 

  NOTE Only messages that fit on your selected VMS will show. 

 

3. Click Activate or double-click the message. 
4. Confirm your choice. Click Display message in the Display message confirmation dialog 

box (see Figure 18). 



Variable Message Signboards  

25 of 71 JamLogic Fleet Management Software Version 3 

 
Figure 19: Display message confirmation window 

 

  TIP 

You can make a message the VMS default message. Once created, right-click the 

device and pick  Change default message in the shortcut menu, to set your 
message as the default message 

 

5.2   Displaying a Graphic on the VMS 
1. Click Display Graphic. 
2. From the Display Graphic window (see Figure 19), browse the folders and select your 

graphic. 

 
Figure 20: Display graphic window 

 

3. Click Open or double-click the message. 
4. Confirm your choice. Click Display message in the Display message confirmation window. 
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5.3   Blanking a Sign 

When there is no relevant information to display for a while, simply click  to blank the VMS. 

5.4   Overriding a Current Message 
If your VMS has automation running on it, you can override the message being displayed on your VMS. 
Note that the automation still runs in the background. The override takes precedence over the 
automation until the message override time expires or until the override is stopped manually. 
 

  NOTE 
The Override Message button, providing you have access, is available only for 
devices running automation. If the override is available, you will see it on the right 
side of the toolbar. 

 

1. To open the Override Message window (see Figure 20), click Override Message  on the 
tool bar. 

 

 
Figure 21: Override Message window 

 

2. Select the Start date by clicking the Start date Calendar button. 
3. Enter the Start time by typing or clicking the up-down arrows. 
4. Select the End date by clicking the End date Calendar button. 
5. Enter the End time by typing or clicking the up-down arrows. 
6. Click Blank message or Select message: 
7. Blank message - Displays a blank message board. 
8. Choose message - Opens the Select a message to activate window (see Figure 17). You 

then select a message by either double-clicking it or clicking Open. 
9. Click OK. 

An Override Message icon displays next to the device icon(s) in the Devices list panel if the particular 
device automation is being overridden. It disappears once you stop the override. 
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5.5   Stopping the Override 
 

 Click Stop Message Override. 
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6 Creating Messages 
The Message Editor window allows you to create or modify messages and store them in your 
organization's message folder. 

6.1   Message Editor Quick Tour 
To open the Message editor window (see Figure 21): 

 Click Message Editor on the tool bar. 

 
Figure 22: Message editor window 

 File and format tool bar. 

 Page features tool bar. 

 Script field displays NTCIP multi-script format of the message. 

 VMS template with message preview. 

 Page preview controls 

 Page index 
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6.2 Toolbars 
 

 
                                                        

1. New message 
2. Open message 
3. Save message 
4. Paste clipboard content 
5. Activate message in preview template on current VMS(s) 
6. Font selection - Applies to the current line 
7. Caps Lock 
8. AutoFont 
9. Default Alignment (varies with the VMS size and template) - Applies to the current line. 
10. Left alignment - Applies to the current line. 
11. Center justification - Applies to the current line. 
12. Right justification - Applies to the current line. 
13. Justify to page 
14. Vertical alignment default - Applies to the page content. 
15. Vertical alignment top - Applies to the page content. 
16. Vertical alignment middle - Applies to the page content. 
17. Vertical alignment bottom - Applies to the page content. 
18. Add Graphic - Allows to import a graphic from a folder.  
19. Line Spacing - Applies to the current line in relation to the line above. 
20. Character Spacing - Applies to the current line. 

 

 
                                                                              

1. Add Page - Adds a new page to the message. 
2. Remove Current Page - Removes the current page from the message. 
3. Insert a Dynamic Tag (see Dynamic data messages for more information). 
4. Page Time ON - Displays time for the current page. 
5. Page Time OFF - Interval between two pages. Applies to the current page in relation to the 

next page. (If the message consists of only one page then the OFF time interval still applies, 
e.g. 2 seconds on, 3 seconds off.) 

6. Blink Time - Applies to the current line. Longer blink times will result in longer display times 
and equally long off (non-illuminated) times. 

7. Page Condition - Pre-formatted script entries for Radar and IO type messages. 
8. Insert Moving Text (can only be applied on existing text). 
9. Beacons - Activates external blinking lights installed on the VMS or speed trailer and defines 

their display pattern. 
10. Page Background Color - Applies to the entire page.  
11. Background Color - Applies to the space between the characters. 
12. Foreground Color - Applies to the characters.  
13. Word Spacing - Defines space between words.  
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6.3 Composing a Message 
 

  NOTE 
The template preview panel within the Message Editor corresponds to the actual 
height/width ratio of the selected VMS. 

 

1. Start typing your message (line feeds are not automatic; you have to press Enter). 
2. Format your message characters, lines, fonts and page (see Format tool bar section for 

format options and details). 
3. You can add page features by clicking/selecting the different features available (See Page 

features tool bar section for options and details). 
4. To preview your message, click Play . All Message Editor functions are disabled while in 

preview mode. 
5. Click Save button to save your message. 
6. Type in the name of your message in the Name field of the Save message window. 

 

 
Figure 23: Save message window 

7. Select/create a folder. 
8. Click Save  button. 

6.3.1 Multiple Pages Message 
 If you lack space in a page for your message, you can always add a new page (Click Add Page).  
 Messages with several pages will display the pages in ordered sequence on the VMS.  
 The number of pages for a message depends on the VMS model. By default, expect the ability to 
insert 64 pages in a message.  
 Use the Page controls to scroll through your pages. 
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6.4   Word Spacing 
The Word Spacing feature in the Message editor window allows you to define the space between 
words when you are composing a message. This feature applies only to full matrix portable message 
signs. The spacing may range between 1 and 8 pixels. The default value depends on the selected font.  
 

  NOTE The Word Spacing feature is included in the AutoFont option. 

 

6.5 Autofont 
 

  CAUTION 
Ver-Mac Inc. cannot guarantee or be held responsible for the AutoFont 
feature with respect to local prescribed character size. 

 
The AutoFont checkbox in the Message editor window allows you to automatically adjust the font size 
and the space between words and letters. As a result, the message format adapts to the length of the 
line.  
 
This option applies only to full matrix portable message signs. The default font size is 5 × 7 pixels, while 
the smallest size is 3 × 7 pixels.  

6.6 Line Spacing 
The letter spacing can decrease from 2 pixels to 1 pixel, while the word spacing varies between 9 and 2 
pixels. Once there is no space left on a single line, a red rectangle appears around the page. 

6.7 Searching for Messages 
The search tool allows you to search for messages using the following filters: 

 Look in the file names - look within the given names of the messages. 
 Look within the message itself for the series of characters. 
 Begins with - limit the search to the beginning of the name or the message. 
 Match case to search with high or low caps. 

Searches are done within the message explorer window. 

1. Click Save  or Open Message  in the Message editor window to open the message 
explorer window. 

2. Type the series of characters to search in the Find text box of the search tool and click the 

search icon .. Pick more filters with the drop-down arrow (see Figure 23). 

 
Figure 24: Search text box with the filtering options 
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The results of the search will appear in the right hand panel. A Search results view is created in the 
folder panel. The location of the selected message appears above Name text box when you select a 
message. 
 

 
Figure 25: Search results 

 

6.8 Copying/Pasting Messages 
It is possible to copy messages and graphics, from any place you find them when navigating files, the 
following way:  

1. Select the folder containing the message(s) to copy. 
2. Select the message(s) to copy. 
3. Right-click the selected message. 
4. Click Copy or press Ctrl-C. 

 

 
Figure 26: Copying or pasting a message 

5. Right-click the selected message. 
6. Click Paste or press Ctrl-V. 

Copied messages will be named with a digit appended to the name. The digit increments with each 
occurrence of a copy. 
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6.9 Making a Message the Default 
When nothing specific is happening, you can have a default message set on your VMS. It could either be 
a blank message or some text or graphic. Some examples would be a local event, a bad weather 
warning, a seasonal warning or a local event.  
 

 
              
 

 
Activate default message will send to the VMS a message you have previously picked 
as default. 

 Change default message opens a navigation window to find a message to use. 

 Set default message as blank turns the screen black when you go back to default. 
 
 

6.10   Dynamic Data Messages 
Dynamic data is data that varies. JamLogic offers five (5) types of dynamic data that can be applied to a 
message: hour, date, temperature, radar and server variables. 

6.10.1 Hour 
Hour displays the current local time (device location). Select the time display format and click Insert. 
 

 
Figure 27: Dynamic data - Time 

6.10.2 Date 
Date displays current date (device location). Select the date display format and click Insert. 
 

 
Figure 28: Dynamic data - Date 
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6.10.3 Temperature 
Temperature displays current temperature on site. Select the temperature unit and click Insert. 

 
Figure 29: Dynamic data - Temperature 

6.10.4 Radar 
Radar displays captured vehicle speed. Select speed unit and click Insert. 

 
Figure 30: Dynamic data - Radar 

6.10.5 Server Variable 
Server variable displays an extracted value from the device logs on the server. Enter the query script 
within the Query string text box and click Insert. 

 
Figure 31: Dynamic data – Server variable 
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6.11  Create a Message Triggered by an IO Device 
An input/output (IO) device is an option that connects physically to the V-Touch controller. The controller 
will translate its signal into a message for the VMS (e.g. 50 km/h). This IO device might be a radar or any 
device which status changes (ON/OFF). 
 

 
Figure 32: Page Condition – no IO device is active 

When there is one IO you must create a minimum of two message pages: 

 A message displays when the IO is Off. 
 A message displays when the IO is On. 

For more than one IO, the minimum number of associated message pages increases exponentially.  
 
For example, for two IOs you must have a minimum of four messages: 

 A message displays when IO #1 and IO #2 are both Off. 
 A message displays when IO #1 is On and IO #2 is Off. 
 A message displays when IO #1 is Off and IO #2 is On. 
 A message displays when IO #1 and IO #2 are both On. 

 

You can also have more than one message page linked to the input from an IO. However they have to 
be the same page conditions for every single page of the multi-page message. 
The table below shows the message pages (single page and multi-page messages) that result from input 
from two IO detector devices. 
 

IO Triggered Messages 
Message  Page Page condition (IO status) 

DRIVE SAFELY Page 1 
 

CAUTION HIGH WINDS Page 2 
 

BLOWING SNOW Page 3 
 

DETOUR NEXT EXIT Page 4 

 ROAD CLOSED Page 5 
 

  NOTE 
When using an IO device, you must always create a message page to display 
when all IOs are Off, even if that page is blank. 

 
To create a message triggered by an IO device:  



Creating Messages  

36 of 71 JamLogic Fleet Management Software Version 3 

1. Select Message editor and create the message page to display.  

2. On the Page features toolbar, click Page Condition to open the Page Condition list. 
Select IO.  

3. Enable IOs according to your needs. 
4. Click Apply to save your page conditions settings. 
5. Add new page(s) as needed and create the next message page(s) to display for the next IO 

activation.  
6. Repeat for all pages and IO activation options.  
7. Use the side arrows to review each page and its associated IO conditions.  

 

  NOTE 
Even if you want the same message page to display for two or more IOs, you must 
set the Page Condition for each IO separately. 
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7 Drawing Graphics 
7.1 Graphic Editor Quick Tour 
To open the Graphic editor window (see Figure 32): 

 Click  Graphic editor on the tool bar. 

 
Figure 33: Graphic Editor window 

 

 File tool bar - New, Open and Save. 

 Drawing tool bar 

 VMS template with graphic preview 
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7.2 Tool Bars 
7.2.1 File Tool Bar 

 
           

1. New graphic 
2. Open graphic 
3. Save graphic 

7.2.2 Drawing Tools Tool Bar 

 
                    

1. Pencil - Pencil drawing tool 
2. Paint bucket - Fills space within an outline 
3. Eraser - Removes pixel color 
4. Rectangle - Draw a rectangle 
5. Ellipse - Draw an ellipse 
6. Import graphic - Import external bitmap image 
7. Foreground Color - Color list 

7.3 Creating your Own Graphic 
The template preview panel corresponds to the actual height/width ratio of the selected VMS. 

1. Select your drawing tool. 
2. Select your color. 
3. Drag the cursor on the panel to draw. 
4. Click Save to save your graphic. 
5. Type in the name of your graphic in the Name text box of the Save graphic window. 

 
Figure 34: Save graphic window 

6. Select/create a folder. 
7. Click Save button. 
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8 Programming Schedules 
To use scheduling you must make sure that: 

 Your VMS is already configured in JamLogic. 
 It is compatible with scheduling. 

If the VMS (variable messaging system) can be scheduled, its corresponding buttons will be available. 

 
Scheduling buttons 

 

  NOTE 

This chapter will use, as an example, a work zone with flaggers during week days 
and light signals outside of working hours. So a VMS will warn of workers week 
days between 7 a.m. and 5 p.m.; it will also warn of light signals at night and during 
weekends. 

 

8.1 Necessary Steps to Schedule a VMS 
The schedule design has these required steps: 

1. Elaborate messages. 
2. Define timespan. 
3. Define the periodicity, that is, the beginning and the end, and when this schedule is to take 

place. 
4. Activate the schedule in the VMS. 

This chapter covers steps 2 to 4. 

8.2 Creating a Schedule 
Once the messages are created, the schedule has to be established and its periodicity (duration and 
repeats). This section describes schedules. 

1. Open the Schedule Editor. There are two ways, the shortcut menu or the tool bar: 

 Right-click the device you wish to schedule and select Schedule editor . 

 
 Select the device and click Schedule editor in the second set of tool bars from the top.  

 
 

The next steps program a single day. 
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2. Click in the required day to add a program. To start a program at midnight (0:00), click the 
black button right under the day to select a message. 

3. To start the program at another hour, right-click the day to program and select Add Program. 
A new color will appear in the selected zone. 

 
4. Change the set time by typing over it. 

 
5. Click the black button to select a message (e.g. Roadwork 9PM-5AM May 3-10). The program 

will be enabled until midnight (12 a.m.) of that day. You can see the message if you mouse 
over the time slot. 
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You can add several time slots in one day. 

 
 
To delete a program, right-click the time slot and select Delete Program from the shortcut menu. 
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8.3 Periodicity 
You can now define your schedule duration and number of repetition. It is called the periodicity. 

8.3.1 Repeating a Program or a Whole Day 
1. Right-click the schedule you have just configured and select Periodicity (program) to repeat 

only one programmed message or Periodicity (day) to repeat the whole day’s programs.  

 

  NOTE 
For the example, a whole day is copied over weekdays, then the night message is 
a repeated program on the Saturday and repeated on the Sunday. 

 

 
2. The Dayplan conditions dialog box appears. 

  
3. In the Periodicity group box, select the program type.  
4. Daily - Activates the program every X days or every work day. 
5. Weekly - Activates the program every X weeks on the selected days of the week. 
6. Monthly - Repeats the program on the selected date or day every X months. 
7. Yearly – Activates the program once a year on a specific date or day of X month. 
8. In the Periodicity range group box: 
9. Click the Calendar icon to select a start date. In the calendar, the start date for the periodicity 

is in blue. If the current date differs from the start date, it will be in grey. 
10. Select the 3rd option button, Ends on. 
11. Click the Calendar icon at the end of the Ends on line and select an end date. Click OK. The 

day copies over to the desired dates. 
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12. Right-click weekend day to add a program for the weekend or for a specific day that is 

different. 

 
13. Check in the Month display mode, to see your complete schedule in one glance. Mouse over 

the days to see what you just programmed. 
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14. Click the diskette icon to save the Schedule editor file. 

 

  CAUTION 
Do not forget to select an end date for the periodicity. Also, it is not advised 
to set it to more than 3 months. 

 
 

  NOTE 
For some panels, you might need to program an empty one if part of the day is 
programmed, but you need to leave a part blank. 

 

8.3.2 Getting around Schedules 
 To verify that schedules operate according to your requirements, click the arrows beside the 
current week or click Month, still in the Schedule editor. You can then see when the program 
ends. Days after, the programmed end date will be blue. 
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 When you mouse over a programmed area, the programmed message will appear. 

 
 In the monthly view, mousing over a day of the month will display the whole day’s program. 

 
 If not already done, click the diskette to save the Schedule editor file. 
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8.4 Activating the Schedule 
The last step consists in activating a schedule on the VMS. 
 
There are two ways to activate a schedule: 

1. Right-click the device and select Activate schedule. 

 
OR 

2. Select the device and click the button Activate schedule in the second tool bar: 

  
An icon will appear in the device’s line indicating that scheduling exits for this equipment (as outlined in 
red). 

 
 
 

  NOTE 
If there is no active message until the beginning of the schedule, it is normal that 
nothing appears in the Value column of your device. 
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9 Preparing a Memory Key for a VMS 
USB Data profile allows you to copy content from JamLogic into one or several USB memory devices to 
copy it into several VMS that you wish to get programmed quickly. You can transfer permanent, variable 
messages and graphics, you can also transfer schedules. For more information on schedules see 
chapter 8, Programming Schedules. For more information on messages and graphics, see chapter 6, 
Creating Messages and chapter 7, Drawing Graphics. 
 
To have access to the USB data profile feature: 

1. Select a VMS in the device list.  

2. Then click the USB Data Profile  button in the VMS tool bar, or right-click the VMS and 
select it from the shortcut menu. The Data Profile window appears: 

 
Figure 35: Data Profile window 

3. Click Add Permanent if you wish to change messages in the VMS in the permanent bank, 
the messages that cannot be modified. 

4. Click Add Changeable to add changeable messages. 
5. Click Add Graphics to add new graphics in the graphics bank. 
6. You can also add a schedule using the Select Schedule button. 
7. When done, click Export to USB memory key.  

This window can be left aside to edit messages in the event you realize some messages are 
missing. If you add the USB device after opening the Data Profile window, make sure you 
see it in the USB key list box. 
 
The rest of the operation is performed on the VMS V-Touch controller via the Data 
Management screen, from the Options menu. 
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10 Updating Controller Passwords 
You can batch-update controllers remotely from JamLogic, if it is a SignCore, a V-Touch controller or a 
RC controller. VMS local controllers have 3 levels of access: Viewer, Guest or Admin. Viewer has no 
password. Typically, a guest is a fleet manager but renting the equipment and an admin is the owner of 
the whole fleet. Passwords in VMS local controllers can be changed remotely for additional security, if 
you rent a fleet, or if it is just a lost password.  

 
Figure 36 - Controller local access login 

 

  NOTE 
SignCore, V-Touch and RC controllers all support the local password, while only 
the RC controller has a Wi-Fi connection. If this is a batch job and you select 
devices that don’t support those features, JamLogic will simply ignore them. 

 

 
To change one or a batch of device passwords: 
 

1. In the Tools menu, click Change Controller Passwords, and a dialog box of the same name 
appears. If this is the first time you use it, it will be empty. 

2. To select devices, click the Devices button. 

 

 
Figure 37: Change Controller Passwords dialog box 
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3. Browse to the required devices and add them using the chevrons (see Figure 37). 

 
Figure 38: Select a Device dialog box 

 

4. Select whether it’s an Interface Password or a Wi-Fi password. 
5. Type the Administrator and Guest password for a local interface, or the password only for 

the Wi-Fi model. 
6. Click Send. The Task Status column will inform you on success or failure of the operation.  

 

This operation could be performed on a large lot, therefore, know that: 

 A Filter group box on the right lets you see only the devices that passed or failed, which will be 
useful to look through a big batch.  
 Click the column header to sort it by name, task status or last change time and date. 
 Once you clicked Send, you can quit JamLogic and the job will continue. 
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11 Cameras and Light Towers 
Devices on a telescopic mast such as cameras, and light towers have a similar configuration in 
JamLogic (see section 4.1). The first section of this chapter covers camera trailers while the second 
section covers light towers and solar power platforms. 

11.1   Controlling your Camera  
Cameras in JamLogic have two functions: 

1. Display a snapshot of the current view (image URL supplied on camera device creation; see 
section 4.1 ). 

2. Enable PTZ (Pan, Tilt and Zoom) camera controls (Camera URL supplied on camera device 
creation; see section 4.1). 

To use the camera from JamLogic 
1. Right-click your camera within the Devices list panel. 
2. Click Control on the context menu (see Figure 38) to open the Camera control window (see 

Figure 35). 

  

 
Figure 39: Camera shortcut menu 
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Figure 40: Camera control window 

 

3. Control your camera 
 

  CAUTION 
The camera control window displays the web control supplied by the maker 
of the camera. Controls and views may vary from one camera to another. 
See your hardware manual for instructions on using your camera controls. 

 

 

11.2   Solar Light Towers  
JamLogic controls some models of solar light towers and power platforms with lights, through a 
WebRelay. Once configured in JamLogic (see section 4.1) you have several controls: 

 Get Status to refresh the information in JamLogic. Resulting logs will be  
 Turn on the light. 
 Turn the light for that will open the Stay On For dialog box to set a length of time. 

   
 
The current status of the light appears in the Value column, as a light bulb that is on or off. 
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12 Solar Regulators 
Jamlogic supports certain types of regulators so you can get their voltage and current status.  

12.1   Adding a Regulator in JamLogic 
If you have a Morning Star Tristar MPPT or a Ver-Mac regulator, you can get their voltage and current 
directly. 

1. From the Device management tool bar, click  New device wizard. This opens the New 
Device Wizard window. 

2. In the top horizontal icon list, select the  solar regulator. 
3. In Generic settings, type a description for the device. 
4. In the Network group, in Protocol, select VIP16 for a Ver-Mac regulator or ModBus for a 

Morning Star. 
5. Enter the modem IP address in the Address text box right under Protocol. 
6. Click Next.  

12.2 Using the Information 
To see voltage and current:  

1. Display the Properties pane: In the View menu, check Properties. 
2. In the Properties pane, in the Misc section, you can read the current in Powers Current and 

the voltage in Powers Voltage. 

 
To generate a report about the solar regulator: 

1. Right-click the regulator. 
2. Select Get Device Data. 
3. Select a Start and End date. 
4. Click Parameters to pick report elements.  
5. You can add more devices if you click the Devices button. 
6. Click Generate. 
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13 Speed Trailers 
Ver-Mac speed trailers have a variety of uses, most often for speed calming around school areas and for 
construction work zones.  
 
In Smart Work Zones, they act as speed displays, radars and data acquisition devices to display 
eventual traffic jams on variable message boards (VMS) installed before the speed trailer. You can setup 
a smart work zone with a speed trailer just before the workers, as a protection, and during rush hour, 
when the speed trailer’s radar will detect slow speed, it could trigger a warning on a VMS (see Figure 
40). 
 

 
Figure 41: Automated variable message board triggered by a speed trailer 

You can use JamLogic, without a modem, to: 

 Build a virtual device with a configuration that you will take with you on a USB device and upload 
it to all speed trailers of the same model.  
 Look at logs gathered in a speed trailer. 

 
You can use JamLogic, with a modem, to connect to the speed trailer: 

 Get device data like any other JamLogic device. 
 Connect the speed trailer to a Smart Work Zone. 
 Manage logs. 
 Send schedules. 
 Send messages and triggers files. 

13.1 Configuring Speed Trailers without Modems 
13.1.1 Preparing a Configuration 
To use JamLogic for a speed trailer configuration, without a modem, you can create a virtual speed 
trailer (see section 4.2). Pick one of 4 available speed trailer models:  

 SP-710V for a 2-digit standard display. 
 SP-715V for a 3-digit standard display. 
 SP-3248V for a 2-digit high density display. 
 SP-3264V for a 3-digit high density display. 

 

  TIP The name you are prompted to give at the end will be the name in the Device List. 
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13.1.2 Preparing Messages and Images 
This feature is very useful for HD models, which are the SP-3248V and the SP-3264V. You can create 
messages and images. If you use JamLogic and select the same model as for your speed trailer on-site, 
all the files will be compatible. Refer to chapter 6 for messages and to chapter 7 to create graphics 
(images). 
 

• Create a folder where all the images and messages will be located for that model. 
• If you want them to appear in a certain order, once you are in front of the speed trailer, you can 

assign numbers to your files. 
 

  NOTE 

For advanced users: HD speed trailer messages are not scripts. When you create 
a message for a speed trailer, it is converted into an image. The speed trailer does 
not have a full keyboard, so images and messages can only be created in 
JamLogic and become all images to be selected even if not used locally. 

 
 

13.1.3   Preparing Triggers 
Triggers are scenarios that contain certain conditions to trigger messages and images in the speed 
trailer.  

13.1.3.1 Speed Trailer Modes 
 

  NOTE 
If you use the speed trailer locally and you are familiar with it, you have to know this 
about JamLogic: In JamLogic, you do not select a trailer mode, it’s the way you will 
configure the triggers that will determine the mode. 

 
There are three operation modes for the speed trailers: 
 
Speed Trailer This mode is the regular mode, displaying current speed and using set speeds. When 

you activate a trigger file with these settings, JamLogic only shows TRIGGER MODE in 
the Value column of the Device List. 

Static Sign This mode simply displays a number, and for the HD models, a message or image. If 
there is no current speed displayed but just numbers or images then JamLogic is in 
static mode. The message or image appears in the Value column in the Device List. 
You are in the static mode if you send messages and images to the speed trailer 
directly and the most it does it alternate between 2 of the three possible: a speed or a 
message or an image. 

Stealth  This mode looks like the sign is off. Speeds are tracked but not displayed. In JamLogic, 
blank the sign and it’s in Stealth mode. 

 

13.1.3.2 Configuring Triggers 
You get to the Speed trailer triggers configuration by a right click on the device (see Figure 41).  
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Figure 42: Shortcut menu for Speed trailer triggers 

For example, you can program a trigger to display a “Slow down” image as shown in Figure 42, as soon 
as the motorists go faster than 32 miles per hour, while displaying the speed. These are files; you can 
set up as many of them as you wish in JamLogic, but only one can go in the speed trailer. 
 

 
Figure 43: Speed trailer triggers configuration dialog box 

Display speed from Determine the speed the sign will start displaying speed information. You 
also have the option of displaying always, or never. One possible scenario 
would be to activate always and alternate between the speed and a 
warning text, such as “school zone slow down”. 

Flash speed from Determine the speed the sign will start flashing, for example, if the speed is 
too high. You also have the option enabling this always, or never. 

Activate beacons from Determine the speed the sign will start the beacons, for example, if the 
speed is too high. You also have the option enabling this always, or never. 
Beacons are available flashing together (synchronized) or not (alternate). 

Display bitmap from Only for the HD models. This is where you get to choose an image that you 
previously conceived with JamLogic (see section 12.1.2). 

Alternate display If you wish to have the speed and an image, select this option.  
Speed unit Pick between miles or kilometers. Note that JamLogic displays units 

according to what was selected in Languages from the Options menu. 
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USB export options At the bottom of the dialog box, if there is a USB device in one of the ports 
while you are using JamLogic, a drive letter will show here and the button 
Export to USB memory key will be available. 

 

When you completed this configuration, you can either save it for later  or activate it  right 
away. The way the speed trailer will behave in JamLogic is different from a real speed trailer, please 
refer to section 12.1.3.1 for more information. 

13.2 Configuring Speed Trailers with Modems 
If there is a modem in the trailer then you can add it right away in your device list. When you have a 
speed trailer with a modem, you can: 

 Send messages directly to the speed trailer. 
 Make messages, images (HD) and speeds display under certain conditions with the triggers. 
 Change the triggers configuration. 
 Configure a schedule of events using either triggers or messages. 

13.2.1 Adding a Speed Trailer in JamLogic 
To add a new speed trailer, you will need its TCP address. Follow the procedure to add a network device 
from section 4.1 and pick VIP16 (see Figure 43). Do not forget the TCP address and its port. 
 

 
Figure 44: Network settings for the speed trailer 

 

  TIP 
 When you add a new device that used to be virtual, the virtual device will 
remain and a new one will appear with its device ID.  
 If you try to import data from an existing real device connected in JamLogic, 
using the Import Radar Data tool, JamLogic will tell you that it already exists. 
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13.2.2 Configuring Schedules for a Speed Trailer 
For more detail on schedules see chapter 8. You can plan messages and triggers files according to a 
specific schedule under the following conditions: 

 There can only one schedule file in a speed trailer. 
 You can plan the three modes as follows: 

o Stealth mode: program a blank message. 
o Static mode: program messages. 
o Speed trailer mode: program a triggers file. You can only send one triggers file to the 

speed trailer. 

 
Figure 45: A speed trailer schedule 

 

  NOTE 
The information for the next status change is kept in memory in case 
communication is lost with JamLogic. That way if a short communication loss 
occurs, the schedule will keep behaving properly for a certain time. 
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14 Radars 
This section covers congestion level parameters for the three types of radars managed by JamLogic.  

14.1 Simple Radars 
A simple radar is a radar that has regular options, such as the Houston and the Ver-Mac Speed-Mac. 

 
Figure 46: Configuration for a (Speed-Mac) radar 

 

 Device type: Select the radar icon. 

 

Speed: Average speed threshold. 
Count: Required vehicle count on a speed threshold.  
Delay IN: Consecutive values needed below threshold to go into lower speed condition. 
Delay OUT: Consecutive values needed above threshold to go into higher speed condition. 

14.1.1 Speed-Mac V2 Setup and Operation 
The Speed-Mac V2 radars use push technology. To set it up: 

1. Select VipPush . 
2. Enter congestion levels as in table above. 

3. Enter the serial number from the unit , which is on a sticker underneath the unit. 

4. Click Next. No communication is required . 
 
After a setup, the device is not set until the server reports "New event or HB". In that case a new 
icon shows up in the Device list to report to the user that it has a pending setup. It gets the 
waiting setup message. Once the Speed-Mac V2 pushes information to the server, the Setup 
pending icon disappears and all your pending requests update at that moment. 
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There are 2 commands, specific to push devices, that are available in JamLogic, therefore only 
apply to the Speed-Mac V2. 
 

 
 

Right-click the Speed-Mac in the device list to: 
 Reboot the device. 
 Synchronize with it to force the device to send its current status such as Voltage, Current, 
Position, Ip Address, Version, Last Radar Stats and Congestion Level. 

There is additional information on the Speed-Mac V2 operation in the operation, safety and 
maintenance manual  

14.1.2 Available Speed Devices States and Travel Time State 

Unknown Not enough data to compute. 

Freeflow Speed is higher or equal than freeflow limit threshold, with desired vehicle count, 
occupancy (RTMS only) for each "Out" delay minutes. 

Slow Speed is under slow limit threshold, with desired vehicle count, occupancy (RTMS only) 
for each "In/Out" delay minutes. 

Stopped Speed is under stopped limit threshold, with desired vehicle count, occupancy (RTMS 
only) for each "In/Out" delay minutes. 

 

14.2 RTMS and Lane Filtering 
RTMS and other radars with more options have an additional column for occupancy and a whole section 
dedicated to lanes. 

 
Figure 47: Configuration for a RTMS  

• Settled values are applied for both directions. 
• Speeds, Counts and Hysteresis have the same meaning as radar. 
• Occupancy: Combined with other setup, the percentage of time a direction is occupied by a vehicle 

during a sampling period. 

Filter Lanes 
Lanes with a lower count is considered as empty. Note that lanes statistics continue to record regardless. 
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15 Data 
Historical data is available via the Show Device Data window but is also used within other modules such 
as automated tasks. Data dating from the past year is usually available. However, only data that has 
been requested will be recorded in the logs. If a status update or other data recording action is not 
requested on device, then no data will be recorded. Automated status updates (in option) can be 
programmed to capture the device data in a defined time frame. Consult the “Logged Data” section of 
the corresponding device to find out which data types are available for that specific device. 
 
The Device Data window presents the logged data from the devices in the form of graphs. 

15.1  Accessing the Data  

To open the Device Data window (see Figure 39), click Show Device Data  on the toolbar or 
right-click the device and select Show Device Data from the shortcut menu. 
 

 
Figure 48: Device Data window 
 

  NOTE 
As with the Logs window, the Device Data window always opens with Start time as 
the current time minus 24 hours. 

 

1. Define a Date/Time period. There are two ways to set the time period in which your Logs are 
located: 

2. Predefined Date/Time ranges 
3. Select a predefined Range from the list box (Last Hour, Last 6 hours, Last Day, Last Week or 

Last Month).  

 

4. Custom Date/Time range 
5. Select a custom Range from the list box (Custom, Hour, 6 Hours, Day, Week or Month). 
6. Select the Start date by clicking the Start date Calendar button. 
7. Enter the Start time by typing or clicking the up-down arrows. 
8. Select the End date by clicking the End date Calendar button. 
9. Enter the End time by typing or clicking the up-down arrows. 

 

2. Set the Period (interval) between each recording. 
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3. Check Merge Devices to merge all the devices data onto same graph. 
4. Click Devices to display the Manage devices window (see Figure 40). 
5. Select the devices that you want to get the statistics for. View the contents of the folders by 

clicking the twisties to expand the folders. Your selected devices appear in the right panel list. 
6. Click OK. 

 

  TIP 
You can select complete folders if you want the data from all the devices in the 
selected folder. 

 

 
Figure 49: Manage devices window with selected devices 

7. Click Parameters to open the Select Statistic Types window. 

 
Figure 50: Selected Statistics Window 

 

  NOTE 
By default, JamLogic automatically selects all the available data types for your 
selected device(s) and displays them in the right side panel.. 
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If a data type is not required remove it from the right panel. 
1. Click OK. 
2. Click Generate. 
3. Click Export if you want to export the data (Excel format). 
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16 Automation Options 
This section describes Automation options in JamLogic and how to configure JamLogic automatons. 
Automatons are available in JamLogic and are configured from the Mailing List Editor and the 
Automation Manager. 

 The Automation Manager provides a dashboard to set the different alarms and mailing groups. 
 The Mailing List Editor allows you to define groups with corresponding e-mail addresses to 
receive alerts defined in the Automation Manager. 

Once you have the Automation option enabled, you have the possibility of three automated alerts 
gathered by an automated Get Status function: communication loss, low voltage and Geo Fence. 
Contact your sales representative if you have interest for such features. 

16.1 Get Status 
In JamLogic, information is gathered from the devices using a command called Get (device) Status. You 
can automate this feature using Get Status in the Automation Manager. JamLogic will gather that 
device’s information according to its nature: 

 VMS: sign status, message preview, voltage, brightness. 
 Radar: speed, occupancy, vehicle count. 
 Speed sign : Sign, speed, vehicle count. 
 ResetBox: voltage, reset count. 

16.2 Communication Loss Alert 
With this alert option, you will receive an e-mail if JamLogic fails to establish communication with the 
selected device. 

16.3 Alerts Manager 
The Alerts manager helps you get information on specific cases. For example, many systems depend on 
batteries. This alert will be triggered by a set voltage level defined in the Alerts, and will send a message 
to a selected email group. 

1. In the Tools menu, select Alerts Manager.  
2. Click a Device button to choose one of your devices. In the dialog box that opens, you can 

pick a device and add it. 

 

 
Figure 51 – Alerts Manager dialog box 
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Here is an exemple of status Voici un exemple d’alerte de statut pour un afficheur de vitesse. Passez la 
souris sur l’icône de paramètre et le message Obtenir statut à chaque 10 minutes(s) apparaît. 
 

 
Figure 52 - Exemple de statut d'alerte 

 

16.4 Geo Fence Alert 
This location-based service is available if the device has GPS. Set a displacement tolerance for your 
device. If your device moves out of the determined perimeter, an alert e-mail will be sent to your selected 
e-mail group. 

16.5 Automation Configuration Flow 
The email alerts and the automated features have no specific order of configuration to work, but it is 
more efficient to follow this order: 

• Setup the device list. 
• Prepare the email alert groups. 
• Go into the Automation Manager to complete the configuration. 

16.5.1 Mailing Lists Configuration 
1. In the JamLogic top tool bar, click @.  

 
 
The Mailing List Editor dialog box is displayed. The Emails column should be empty. The 
Groups column lists all the groups you have configured and the Emails column displays the 
selected group’s email recipients. 
 

 
2. In the Groups column, type a name for the group you will be using for each alert. Create as 

many groups as you wish depending on possible combinations. 
3. In the Emails column, type as many emails as required for each group. Click OK when 

finished. 
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You can go back anytime to the Mailing List Editor to add or remove list members as you 
wish. 

16.6 Using the Automation Manager 
From the Tools menu, select Automation Manager. The Automation Manager window appears. Two 
tabs are available, to see the Automations by device or by type. In the Sort by Type tab, you see all 
devices in one glance.  
 
 

  TIP 
You should go into the Mailing List Editor before configuring alerts (see section 14.6). 
If no groups are configured as destination email messages, only Default will appear in 
the alerts configuration. 

 
 

  
Figure 41: Automation Manager window 

The optional items in the Automation Manager are numbered so you know how many licenses are 
available for each. The number of licenses cannot be exceeded, but if the device is part of a Smart Work 
Zone (SWZ), it will not decrease the number of licenses. The SWZ column indicates if the device is part 
of a SWZ.  
 
If you click a column header, it will sort it in order; alphabetical if it is words, from small to big if it is 
numbers. 
 

16.6.1 The Automation Manager Device Tab 
Here is a description of all columns in the Sort By Device tab of the Automation Manager. 
Type This column states if this is a VMS, a radar/RTMS or a ResetBox. 
Folder The Folder column describes the location in the Folders list where you can 

find the device being configured for automation. 
Name This column contains the name given in the Device Properties. 
SWZ Checkbox in this column will be enabled if the device is in a Smart Work 

Zone. 
Get Status In this column, type the time between status updates for this specific device. 
Get GPS Position If the device has a GPS, type the time between device position updates for 

this specific device. 
Get Signal Strength Modem signal strength will be updated at the number of minutes set in this 

column, if the device has a modem. 
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Alerts column See dedicated table next. 
 
 

  NOTE 
Click Save every time you change something in the Automation Manager. That 
change will be lost if you switch tabs or you go to another line. 

 
Alerts Column 
common settings 

Delay: time to wait until sending an alert message to the configured group.  
Email group: the last setting in all alert settings, use it to pick the email alert 
group configured in the Mailing List Editor. 

Low Battery In this column, you can enable E-Alerting for low battery voltage (providing 
there are sufficient licenses). Select a low-battery threshold voltage and an 
email group.  

Comm Loss In this column, enable the alert based on the device’s communication status 
to get an alert email (providing there are sufficient licenses). 

Slow Speed This information is linked to the radar. Slow speed alerts will be sent 
(providing there are sufficient licenses) as detected by the radar after the 
delay configured in this column. Check Downstream if you wish only that 
direction to be detected. 

Geo Fence Alert In this column, providing there are sufficient licenses, you can enable the alert 
based on the device’s position given by the GPS.  
Note: you need a supported modem to use this option. 

Temperature Devices have many temperature sensors (ambient, sign case, weather 
station temperature…) and this setting will send an alert (providing there are 
sufficient licenses) when any of the sensors information steps outside of 
temperature set with this alert. 

 
 

  TIP 
To add or delete alerts, you need to select the line first. When the line is highlighted, 
then the Delete button will appear. 
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16.6.2 The Automation Manager Type Tab 
The Type tab was added in the Automation Manager to change one alert setting for all devices. This is 
very useful when elaborating a Smart Work Zone. This type is divided in two sections: 

 
• Automations: to set one Get Status, one Get GPS Position, or one Get Signal Strength delay for 

ALL devices at once. You can add more devices: you have to click  and a browser 
window will let you pick it. 

• Alerts: to configure 1 alert for all LowBattery, CommunicationLoss, SlowSpeed, Temperature or 
GeoFence. GeoFence will be available only if all devices have a GPS. 

 

  NOTE 
Click Save every time you change something in the Automation Manager. That 
change will be lost if you switch tabs or you go to another line. 
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17 Logs 
Logs contain records of incoming data, error and status messages and transaction details for devices. 
As well, they indicate start and stop times of all the tasks. Information contained in the Logs can be 
helpful in the event of a failure or for administrative purposes. They are presented in the form of rows 
within a table. 

17.1   Accessing the Logs 
To open the Logs window (see Figure 36) 

 From the Tools menu, select Logs. 

or 

 Click Logs on the tool bar. 

  

 
Figure 53: Logs window 

 
 

  TIP 

Logs can contain immense quantities of data and can result in a long download time, 
depending on Internet connection speeds. Therefore, it is strongly recommended that 
you limit your search of the Logs to a very precise time period and filter to restrict the 
search criteria to exactly what you want. 

 
 

  NOTE The Logs window always opens with Start time as the current time minus 24 hours.. 

 
  

1. Define a Date/Time period. There are two types of Date/Time ranges you can use: 
2. Predefined Date/Time ranges 

 Select a predefined Range from the list box (Last Hour, Last 6 hours, Last Day, 
Last Week or Last Month).  

3. Custom Date/Time range 
4. Select a custom Range from the list box (Custom, Hour, 6 Hours, Day, Week or Month). 
5. Select the Start date by clicking the Start date Calendar button. 
6. Enter the Start time by typing or clicking the up-down arrows. 
7. Select the End date by clicking the End date Calendar button. 
8. Enter the End time by typing or clicking the up-down arrows. 

 
Refine your search. Select the defining characteristics (listed below) of the information you require. 

 Automated tasks - Includes or omits server initiated actions. 
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 Errors - Include or omit errors. 
 Action - Contains a list of possible actions initiated by a user or automation. 
 Type - Contains a list of device task types. 
 Table - Lists the grouping options of the items. 
 Search - Uses a name or part of a name to act as a filter on the search. 

  
 

  NOTE Certain actions are associated with unique types, disabling the Type selection. 

 
  

9. Click Generate to send your query. 

  

  
Figure 54: Logs window with query result 

 
 
You can copy-paste any information in that list into an Excel empty spreadsheet to reuse the information. 
 



Troubleshooting  

70 of 71 JamLogic Fleet Management Software Version 3 

18 Troubleshooting 
Troubleshooting is intended as a first step in diagnosing JamLogic and unit problems yourself.  
Troubleshooting is not intended to be a complete guide to all possible problems. It contains information 
on how to resolve some of the common difficulties that users may experience when using JamLogic. 

18.1 Status Indication 
The following table lists possible icons that can display in the Devices list in the JamLogic main window.  
 
Color codes follow 3 levels:  

 Green is OK. 
 Yellow means an error that does not keep the device from working. 
 Red means the device is not operating properly. 

 
Icon Indication Displays when… 

 
OK No errors. 

 
Battery Warning The voltage level is less than a low battery threshold. 

 
Geofence Warning A device was moved. 

 
Controller Error Any error associated with attached, supported and enabled 

external devices occurs. 

 
Fan Error Any error associated with the climate control systems such as 

fans and/or heaters occurs. 

 
GPS Error Communication with the GPS cannot be established.  

 
Humidity Error Humidity sensors are reporting an error. 

 
Mail Error There are errors associated with the e-mail alerts.  

 
Photocell Error There are errors associated with the supported light sensors. 

 
Pixel Error There are errors associated with pixels. 

 
Power Error There are errors associated with the component’s power 

supply. 

 
Slave Error There are errors associated with traffic lights controller.  

 
Temperature Warning Any of the temperature values detected by the device exceed 

non-standardized temperature values. 

 
Activation Error A message is not activated correctly. 

 
Communication 

Timeout The maximum communication delay with a device has expired. 
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Icon Indication Displays when… 

 
Critical Temperature 

The critical temperature, as defined by the value of the critical 
temperature objects, was exceeded. Message cannot be 
displayed due to a sign temperature error. 

 
Error Any error occurs with JamLogic. 

 
Invalid Hardware The controller detected a newly connected device or a 

removed device. 

 
Lamp Error A lamp in the signal head is not fully functioning. 

 
No Speed No speed data is received. 

 
Unknown Error The source of the error is unknown. 
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